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The European Commission support for the production of this publication does not constitute 

an endorsement of the contents which reflects the views only of the authors, and the 

Commission cannot be held responsible for any use which may be made of the information 

contained therein. 

You will notice that the QR codes used for the hand-in application are not present in these 

tasks. To use the tasks with the hand-in application the collaboration with the project team 

is necessary, so please contact us by mail. 
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The first box – Video Box, contains various topics related to the basic knowledge of IT (mobile devices), 

which should teach children how to properly use ICT for an issue or problem at hand. Besides that, 

tasks are aimed at teching children to think creatively while using different mobile applications. In 

various tasks, they will discover the YouTube environment, they will be able to edit photos, create 

short “movies”, etc. 

This box also provide additional tasks (e.g. trip to a ZOO / botanical garden / woods or any other place 

of interest; introducing your role model) in which children can use already acquired IT skills. More 

advanced tasks (e.g. creating stop-motion videos from toys or drawings) are available, too. 

List of Topics: 

Topic a: Getting started 

Topic b: Do you want to be a YouTuber? 

Topic c: Why are some videos good and others are not? 

Topic d: Be a professional movie editor! 

Topic e: Be a professional movie reviewer! 

Topic f: Stop-motion video from drawings 

Topic g: Stop-motion video from toys 

Topic h: Trip to a ZOO / botanical garden / woods or any other place of interest 

Topic i: Introducing your role model 
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Connection to other boxes:  
- This box should be the first box within the learning process as it teaches children how to properly 

use their mobile devices. Skills achieved in the Video Box are crucial for handling activities from other 

boxes. 

4



The goal of the topic “Getting started” is to improve children’s IT literacy. By completing these tasks, 

children should learn how to properly work with the mobile devices, understand their basic functions 

and be able to use them to take photos, videos, etc. (see further description of the taskgroups and 

tasks).  

Taskgroups and tasks 
This topic contains eight tasks. In the first task (“Working with QR codes”), children will discover the 

QR codes – they will learn what these black-and-white squares mean, for which purpose they can be 

used or how the mobile device recognizes them. In the task 2 and 3, children will more closely discover 

their mobile devices in terms of their functionalities. In the second task (“What is on my mobile device 

display?”), they should understand what kind of signs they can find on the main screen and discuss 

what they mean. In the third task (“What apps do I have on my mobile device?”), children should figure 

out which applications are already installed in their devices. Task 4, 5 and 6 (“Taking pictures”, “Adding 

effects to the photo”; “Further effects”) are mainly focused on taking pictures, as well as adding various 

effects to the photo. After that, children should make the introductory videos of themselves (task 7 – 

“My first video”). Task 8 (“Summing up”) provides the summary of previous tasks (for instance, children 

should choose their favourite photo). 

Goals: 
- To understand the meaning of the QR codes and the way how they can be recognized by the mobile 

devices. 

- To learn how to properly use mobile devices (understand basic functions, signs on the main screen 

and their meaning). 

- To understand the usage of the mobile applications, to figure out which applications are already 

installed in their devices. 

- To learn how to take photos/videos. 

- To learn how to properly use various mobile applications in order to edit photos/videos. 

Skills/Competences addressed: 
- Be able to elaborate, refine, analyse and evaluate one’s own ideas in order to improve and maximize 

creative efforts. 

- Evaluate. Assess claims and arguments. 

- Analyse and evaluate major alternative points of view. 

- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 
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- Ability to search, collect and process (create, organize, distinguish relevant from irrelevant, subjective 

from objective, real from virtual) electronic information, data and concepts and to use them in a 

systematic way. 

- Ability to search, collect and process written information, data and concepts in order to use them in 

study and to organize knowledge in a systematic way. Ability to distinguish, in listening, speaking, 

reading and writing, relevant from irrelevant information. 

- Access ICT efficiently (time) and effectively (sources). 

- Use ICT accurately and creatively for the issue or problem at hand. 

- Manage the flow of information from a wide variety of sources. 

- Employ knowledge and skills in the application of ICT and media to communicate, interrogate, present 

and model. 
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The topic “Do you want to be a YouTuber?” is closely related to the previous topic as its aim is to 

expand children’s ICT knowledge, with the emphasis on the YouTube environment. Children should 

create their own YouTube channels and explore possibilities given by this platform (e.g. finding 

favourite YouTube video, recording short videos, etc.). 

IMPORTANT! 

Annex 1 provides the explanation how to find favourite video on YouTube/via YouTube application. 

 

Taskgroups and tasks 
This topic consists of five tasks. Task 1 and task 2 represent technical task teaching children basic skills, 

which are essential while working with YouTube. In the first task (“Create a YouTube channel!”), 

children will become the “YouTubers” by creating their own YouTube channels (Google account is a 

necessary condition in this case). The second task (“Download YouTube application!”) can be 

successfully completed thanks to the acquired skills from previous topic (topic Getting started, task 3 

- “What apps do I have on my mobile device?”). Teachers might need to help or explain children which 

app store is appropriate to use for particular type of their mobile devices. The following tasks are 

primarily focused on video – “Find your favourite YouTube funny video” (task 3), “Record a video about 

a famous person you admire!” (task 4) and “Be a journalist for one day!” (task 5). Recorded videos 

should not be long (they should not exceed 3 minutes). 

Goals:  
- To discover the YouTube environment. 

- To be able to create own YouTube channel and learn basic information about this service. 

- To use YouTube as a tool for finding information. 

- To learn how to take videos and upload them. 

Skills/Competences addressed: 
- Create new and worthwhile ideas (both incremental and radical concepts). 

- Develop, implement and communicate new ideas to others effectively. 

- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 

- Ability to search, collect and process (create, organize, distinguish relevant from irrelevant, subjective 

from objective, real from virtual) electronic information, data and concepts and to use them in a 

systematic way. 
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- Ability to access and search a range of information media including the printed word, video and 

websites and to use internet-based services such as discussion fora and e-mail. 

- Access ICT efficiently (time) and effectively (sources). 

- Manage the flow of information from a wide variety of sources. 

- Employ knowledge and skills in the application of ICT and media to communicate, interrogate, present 

and model. 
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Annex 1:  
How to find favourite video on YouTube: 

1. Open the browser window and use www.google.com address (red square with No.1). 

2. Put the keywords (e.g. “Finding Dory trailer”) into the Search line (red square with No.2). 

3. Click on Search (blue Search symbol at the end of the Search line). 

4. Click on the first result from the list (red square with No.3). 

 
Fig. 1: Screenshot of Google Search © GOOGLE 

5. View the video you choose on m.youtube.com (mobile version of YouTube). 

 
Fig. 2: Screenshot of Youtube © YOUTUBE 
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How to find favourite video via YouTube application: 

1. Open the application window and use Search icon (at the right top corner of the application

window – sign in yellow circle).

Fig. 3: Screenshot of Youtube © YOUTUBE

2. Put the keywords (e.g. “Finding Dory trailer”) into the Search line.

3. Tap on the first result from the list.

Fig. 4: Screenshot of Youtube © YOUTUBE
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The aim of the topic “Why are some videos good and others are not?” is to support children’s critical 

assessment and to improve their technical skills. Children will create their own videos and apply step-

by-step new features of the video editing. 

Taskgroups and tasks 

This topic consists of four tasks. Task 1 and Task 2 focus on the planning of the video’s content. Task 3 

is related to technical issues and Task 4 supports children’s creativity and allows them to apply acquired 

knowledge and skills. In the first task (“First comes the plan!”), children will learn an importance of the 

planning when they want to make a good video. In the second task (“Learn how to make a really good 

video!”), they will use their plan to record short video shots. Moreover, they will have the possibility 

to discuss in a group and critically assess some technical stuff related to the video recording. In the 

third task (“Recognize the difference between the details and the whole surrounding”), they will 

specifically deal with an issue of wide, medium and close-up shots. Last task (“Show us where you 

live!”) will give children the possibility to create their first “professional” video based on their previous 

knowledge and skills. These two last tasks are voluntary. 

Goals:  
- To understand important phases of the video making process. 

- To become familiar with technical issues related to the video production. 

- To be able to individually make a video of a good quality. 

Skills/Competences addressed: 
- Use ICT accurately and creatively for the issue or problem at hand. 

- Employ knowledge and skills in the application of ICT and media to communicate, interrogate, present 

and model. 

- Use technology as a tool to research, organize, evaluate and communicate information. 

- Know when it is appropriate to listen and when to speak. 

- Leverage social and cultural differences to create new ideas and increase both innovation and quality 

of work. 

- Set and meet goals, prioritize, plan and manage work to achieve the intended result even in the face 

of obstacles and competing pressures. 
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The aim of the topic “Be a professional movie editor!” is to build on previous knowledge and to teach 

children how to edit already recorded videos. 

  

Taskgroups and tasks 
This topic consists of one complex task. In the task 1 “Simple video editing” children will learn more 

advanced features of the video editing, for example adding effects, cutting of wrong parts or adding 

music to the video. They will have a possibility to improve their previously recorded videos. 

Goals:  
- To improve their technical skills in order to make a video more professional. 

- To be involved in all phases of video making. 

- To understand objectives of the video editing. 

Skills/Competences addressed: 
- Create new and worthwhile ideas (both incremental and radical concepts). 

- Develop innovative and creative ideas into forms that have impact and be adopted. 

- Use various types of reasoning (inductive, deductive, etc.) as appropriate to the situation. 

- Utilize the most appropriate media creation tools, characteristics and conventions, expressions and 

interpretations in diverse, multi- cultural environments. 
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The aim of the topic “Be a professional movie reviewer!” is to give a chance to use all knowledge and 

skills in practice and to critically asses own and others’ work. 

IMPORTANT! 

All useful features of the Movie Maker program and the procedure of uploading a video on YouTube 

are presented in Annex 2. 

 

Taskgroups and tasks 
This topic consists of two tasks. In the task 1 “Prepare the final version of your video!”  children should 

act as real directors and prepare a movie consisting of the videos they did so far. They will mainly use 

skills from previous two topics. In the task 2 “Give and receive feedback!”, children will express their 

own positive and negative opinions on movies of other classmates. Finally, they can upload their videos 

on a YouTube channel. 

Goals:  
- To make a movie by joining several video parts. 

- To form and express an opinion. 

- To be able to objectively asses the videos. 

Skills/Competences addressed: 
- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 

- Utilize the most appropriate media creation tools, characteristics and conventions, expressions and 

interpretations in diverse, multi- cultural environments. 
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Annex 2:  
Discovering and understanding the main screen of the Movie Maker: 

Open the program “Movie Maker” and start a new project by going to File > New Project. You can see 

three parts of the screen while editing your video: 

Ribbon: The Ribbon enables you to access various editing tools, such as transitions, effects, captions, 

audio levels, etc. You can also add videos, photos, audio files or save your project using the disk icon 

located there as well. 

Preview Window: In the preview window, you can view the video playback of your project and see 

how it will look like when you finish the project. You can use the rewind, fast forward or play button 

or toggle between the full screen and small screen mode. 

Storyboard/Timeline Window: Your video sequence is saved in this window. It also contains your 

imported video clips. In the storyboard/timeline window, you can switch between your clips, split them 

when necessary or arrange them in the sequence. 

Fig. 5: Screenshot of Movie Maker © MOVIE MAKER
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Importing files: 

Click on the button “Add videos and photos”: 

Fig. 6: Screenshot of Movie Maker © MOVIE MAKER

The pictures and the video clips can be imported by clicking either on “Add videos and photos” button 

(at the Home tab) or by clicking on the button at the storyboard window) > find the file folder(s) > 

select all the files you want to use in your project > click on Open. Then the files will be imported into 

the Storyboard / Timeline Window. 
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Importing music: 

If you are making a music video-type project, you should import the music file first, since the music will 

dictate how the images / videos will be edited at the timeline. To import the music file just click on the 

“Add Music” icon (you have the option to add your music at the beginning of the project or in any later 

part of the timeline) > find the file folder > select the music file > click on Open. 

Click on the button “Add music”: 

Fig. 7: Screenshot of Movie Maker © MOVIE MAKER

The imported music file will appear as a bar below the images, with its duration visually depicted by 

the length of the bar: 

Fig. 8: Screenshot of Movie Maker © MOVIE MAKER
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Saving videos: 

To save your new project, you have to name it and choose a destination folder for the project to save 

to. We recommend saving it as often as possible while working with project to avoid losing any editing 

progress – in case of crash or freezing of the programme. 

Click on the “File Menu” icon at the top-left corner > select Save Project As > choose the folder location 

where it should to be saved (the same folder for all project files is recommended) > type in the File 

Name > click on Save. 
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Moving/Editing files: 

Move the images and movie files in the order you wish them to appear in the movie by manually 

dragging the thumbnails left / right / up / down. 

You can also use the Cut-and-Paste shortcut command by selecting and cutting (Ctrl+X) an image or a 

video and pasting it (Ctrl+V) to the desired point at the timeline. Note that the pre-organization of the 

files is very beneficial - if you rename your files in a chronological order, they will be imported and 

placed at the timeline in the same order ant you do not have to move and arrange them one-by-one. 
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Editing photos: 

There is only one editing option for images in the Movie Maker (but very important one) - setting the 

time duration of the image at the timeline which will define how long a certain image will appear in 

the movie. 

Select a particular image, click “Edit” in the Menu of the program Movie Maker (highlighted in yellow) 

and set the desired time duration (in seconds) either by: 

 Choosing one of the pre-set time durations in the drop-down list.

 Typing in the exact time duration.

Fig. 9: Screenshot of Movie Maker © MOVIE MAKER
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Editing videos: 

Can be found in Video Tools > Edit (the same as for editing images). Split and Trim tools will be 

discussed later. 

The video-editing features include: 

Audio Settings Adjustments: include Video volume adjustment (no sound to full sound) and Fade in 

and Fade out speed selection (none, slow, medium, fast). 

Video Speed Adjustment: possibility to create dramatic "slow-motion" effect at the speed of 0.125x 

or "high-speed, fast-paced" action scenes with playback speed 64x. 

Fig. 10: Screenshot of Movie Maker © MOVIE MAKER
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Split tool: 

Split tool can be found in Video Tools > Edit. 

To cut up any video imported to the Movie Maker, first click on the Edit tab in the section Video Tools 

and find the Split button. In your video sequence either drag the black cursor or play the video and hit 

stop where you want to split your clip and then click on Split. Movie Maker will now split the clip at the 

time you have chosen and create two separate clips. If you need to split your clip to create an individual 

clip for the second time, you can either move to another part of the sequence, add a transition or 

delete the whole part. 

Fig. 11: Screenshot of Movie Maker © MOVIE MAKER
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Trim tool: 

Trim tool can be found in Video Tools > Edit. 

Trimming clips in your sequence is a useful tool if you want to get rid of a part of a clip, but do not want 

to delete it entirely. Movie Maker’s Trim tool allows you to select a clip within your sequence and trim 

as much out of the middle of the clip as you want. Tool will connect the beginning and the end of the 

trimmed part and form a new sequence. The trimmed part of the clip will not be deleted. The program 

only hides what you have trimmed and it will not show it up during the video playback. 

 

 
Fig. 12: Screenshot of Movie Maker © MOVIE MAKER 
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Editing music: 

Music files have editing options similar to those of the videos. These can be found in Music Tools 

(highlighted in green). 

The music-editing options include: 

Audio Settings Adjustments: include Music volume adjustment (no sound to full sound) and Fade in 

and Fade out speed selection (none, slow, medium, fast). 

Split Tool: enables you to split your music file into two or more parts by moving the vertical bar to the 

specific point / time you would like the music file to be split at. 

Set start time: allows you to set the point at the timeline when you would like the music to start 

playing. You could do this by either typing in the exact start time or clicking the up and down arrows. 

Another alternative method is to manually drag the music bar to the point at the timeline you would 

like the music to start playing. 

Set start / end point: an exact equivalent of the Video Tools Trim Tool, this enables trimming the 

selected music so it starts / ends at the specified point of the timeline. Trimming can be done in two 

ways: 

 Manually move / drag the vertical bar to the specific point of the timeline where you would

like the music to start, then click on Set start point to trim the music at this point. Do the same

to set the end point by clicking the Set end point.

 Set the Start point and End point by typing in exact times or clicking the up and down arrows.

Fig. 13: Screenshot of Movie Maker © MOVIE MAKER
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Miscellaneous tools: 

They can be used for duplicating files, removing files, selecting files or rotating images / videos. 

Fig. 14: Screenshot of Movie Maker © MOVIE MAKER

Duplicating Files: you may copy images / videos / music files by simply selecting the thumbnail / item 

> click on the Copy icon or press Ctrl+C > paste it on the specified point of the timeline. Note that the 

copied file will have the same added effects (transitions, zoom, etc.) as the original file. 

Removing Files: just select the file(s) you would like to remove and click on the Remove icon or simply 

press the Delete key on your keyboard. 

Selecting Files: you may select a single file (clicking on a thumbnail / item), multiple files (selection 

using Ctrl+right mouse button or Shift+arrow keys), or all files (click on the Select all icon or press 

Ctrl+A). 

Rotating Images / Videos: click on the Rotate Left or Rotate Right icon to change the orientation of 

your images or videos (useful if proper re-orientation of images was overlooked prior to the post-

editing in the Movie Maker). 
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Adding transitions: 

Transitions can be found by clicking on the Animations icon. 

To add transitions, select the clip you would like to use a transition on and click on the Animations tab 

on the ribbon toolbar to see all transition possibilities. Hovering your mouse over a specific transition 

runs an example of what it looks like in the preview window. Once you have decided which transition 

you would like to use, just click on it and it will be attached to the clip. You can also adjust the duration 

of the transition from 0.25 second to 2 seconds. 

 

 
Fig. 15: Screenshot of Movie Maker © MOVIE MAKER 
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Adding effects: 

This tool is located in the Visual Effects tab on the ribbon toolbar. 

Just hover your mouse over a specific effect and the player displays a preview of how the effect will 

look like in your movie. Once you found the effect you would like to use, just click on it to attach it to 

the clip. 

Fig. 16: Screenshot of Movie Maker © MOVIE MAKER

Removing transitions and effects from your timeline is as easy as attaching them: 

 For removing transitions, choose the clip with the transition and go to the Animations tab.

Scroll up to the top of the list and select “No transition”. Your clip will be shown in its original

version.

 For removing effects, choose the clip with the effect and go to the Visual Effects tab. Scroll up

to the top of the effects list and select “No Effect”. Your clip will be shown in its original version.
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Titles, Captions, Credits: 

These three alternatives are used in different periods of the video timeline: titles are added at the 

beginning of the movie, captions during the movie, while credits are added at the end. 

These can be added by clicking either on the Title, Caption or Credit icon at the Home tab > a text box 

will appear in the particular slide or image / video > type in the text > re-size the text box > move by 

dragging the text box to the desired area on the screen. Texts appear as peach-colored bars at the 

bottom of the pictures and video clips at the timeline. 

Text-editing options are available via Text Tools (highlighted in peach). You can access these by simply 

clicking on the text bar at the timeline to open the Text Tools sub-menu.  

The text-formatting options include: 

Font Settings: enable you to change the font type, font size, font color, bold, italicize. 

Paragraph Settings: enable you to change the text alignment (left, center, right) and the transparency 

of the text. 

Text Editing: allows you to change the text. 

Background Color: enables you to change the background color (whole screen) of the titles and credits, 

but not of the captions (since they are positioned over the images and the video). 

Start Time: set the time when you want the text to start showing at the timeline by typing in the exact 

time (in seconds) or using the up / down buttons. 

Text Duration: similarly to the images and video clips, you can set the duration you would like the text 

to appear in the movie (by typing in an exact time or selecting one of the pre-set time durations). 

Effects: similarly to images and video clips, texts also have animation options. Simply select the text 

animation you like from the drop-down menu. 
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Reviewing and finishing the movie: 

Timing is everything. Watch the whole movie to check for potential problems which might be related 

to the scene transitions, visual effects, sound effects, and background music. Ideally, all movie 

elements should be synchronized together. Off-timed elements should be corrected. 

Visual Quality: Check for any inconsistency in the quality of images / videos, such as in brightness, 

contrast or lighting. Correct them if possible. If animations are used, check whether you did not skip 

any image or video, which might need transition or visual effect. Do the same for the text captions if 

they were used. 

Sound Quality: Check the sound quality (abrupt changes in volume, incompatible fade in / out, 

presence of the background noise, imbalanced sound or voice). 

Correcting Issues: After checking all problematic issues, correct them. 

Final Review: Watch the movie for the last time. If everything is ok, save your movie. Otherwise, revise 

again until you are completely satisfied with the final project. 
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Saving the movie: 

You can save the movie in your computer by clicking on the “Save Movie”. The drop down menu offers 

several file formats for your movie. You can even save your movie in a format which allows you to 

easily send it via email. The first choice in the drop down menu is Movie Maker’s recommended format, 

which is generally a good choice for playback on your computer or burning a movie to the DVD. 

Choose the format you would like your movie to be saved as, select a destination folder to save it, click 

on Save and your finished movie will be converted and stored in your computer. 
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How to upload your video on YouTube: 

1. Click on the account icon  to view the user’s profile. 

Fig. 17: Screenshot of Youtube © YOUTUBE

2. Click on the upload icon . 

3. Select the file you want to upload.

Fig. 18: Screenshot of Youtube © YOUTUBE

4. Fill out all fields related to the video – Name, Description, Privacy Settings (at this point, leave

it Public). You can also add it to your playlist, add Tags, Thumbnails, etc.

For detailed procedure, follow the video tutorial: 

https://support.google.com/youtube/answer/57407?hl=en&ref_topic=2888648 
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This topic belongs to the additional part of the Video box. Tasks are rather voluntary as this stop-

motion technique is more advanced – it is on the teachers to decide whether their children are able to 

complete these tasks. The aim of the topic “Stop-motion video from drawings” is to make children 

familiar with alternative possibilities of recording, editing and reviewing a video. 

Taskgroups and tasks 
This topic consists of three tasks. In the task 1 “Understanding how stop-motion videos work”, children 

will watch a YouTube video and their task will be identify steps which are necessary for the creation of 

a stop-motion video. In the task 2 “Make your own video “, children will use their own creativity and 

plan and record their own stop-motion video from drawings. In the task 3 “Adding stuff to your video”, 

they will edit and add further features to the videos. 

Goals: 
- To learn alternative forms of the video making. 

- To understand the process and particular steps necessary for the creation of a stop-motion video 

from drawings. 

- To improve technical skills related to the video making (editing, adding effects, etc.). 

Skills/Competences addressed: 
- Create new and worthwhile ideas (both incremental and radical concepts). 

- Be able to elaborate, refine, analyze and evaluate one’s own ideas in order to improve and maximize 

creative efforts. 

- Use various types of reasoning (inductive, deductive, etc.) as appropriate to the situation. 

- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 

- Use technology as a tool to research, organize, evaluate and communicate information. 

- Use digital technologies (computers, PDAs, media players, GPS, etc.), communication/networking 

tools and social networks appropriately to access, manage, integrate, evaluate and create information 

to successfully function in a knowledge economy. 

- Develop innovative and creative ideas into forms that have impact and be adopted. 

- Utilize the most appropriate media creation tools, characteristics and conventions, expressions and 

interpretations in diverse, multi- cultural environments. 
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Similarly as in the previous topic, this topic belongs to the additional part of the Video box. Tasks are 

rather voluntary as this stop-motion technique is more advanced – it is up to the teachers to decide 

whether their children are able to complete these tasks. The aim of the topic “Stop-motion video from 

toys” is to make children familiar with alternative possibilities of recording, editing or reviewing a 

video. 

Taskgroups and tasks 
This topic consists of three tasks. In the task 1 “Understanding how stop-motion videos work”, children 

will watch a YouTube video and their task will be to identify steps which are necessary for the creation 

of a stop-motion video. In the task 2 “Make your own video “, children will use their own creativity, 

plan and record their own stop-motion video from toys. In the task 3 “Adding stuff to your video”, they 

will edit and add further features to the videos. 

Goals: 
- To learn another way how to create a stop-motion video. 

- To understand the process and particular steps necessary for the creation of a stop-motion video 

from toys. 

- To be able to create a more professional video (e.g. adding further features to the videos). 

Skills/Competences addressed: 
- Create new and worthwhile ideas (both incremental and radical concepts). 

- Be able to elaborate, refine, analyze and evaluate one’s own ideas in order to improve and maximize 

creative efforts. 

- Use various types of reasoning (inductive, deductive, etc.) as appropriate to the situation. 

- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 

- Use technology as a tool to research, organize, evaluate and communicate information. 

- Use digital technologies (computers, PDAs, media players, GPS, etc.), communication/networking 

tools and social networks appropriately to access, manage, integrate, evaluate and create information 

to successfully function in a knowledge economy. 

- Develop innovative and creative ideas into forms that have impact and be adopted. 

- Utilize the most appropriate media creation tools, characteristics and conventions, expressions and 

interpretations in diverse, multi- cultural environments. 
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Similarly as in the previous topic, this topic belongs to the additional part of the Video box. Tasks are 

rather voluntary – it is up to the teachers to decide whether their children would like and be able to 

complete these tasks. The aim of the topic “Trip to a ZOO / botanical garden / woods or any other 

place of interest” is to make children familiar with alternative possibilities of recording, editing a 

reviewing a video on the example of the particular trip. 

Taskgroups and tasks 
This topic consists of three tasks. In the task 1 “Taking the pictures and recording the videos”, children 

will go out, make the photos and record the videos of everything they like. In the task 2 “Making the 

video “, they will join separate parts of the video in the meaningful manner. In the task 3 “Adding stuff 

to your video”, they will edit and add further features to videos. 

Goals: 
- To continue working with mobile devices (taking photos/videos). 

- To be involved in all phases of the video making. 

- To think creatively and be able to write a short script of the video. 

- To improve technical skills related to the video making (editing, adding effects, etc.). 

Skills/Competences addressed: 
- Create new and worthwhile ideas (both incremental and radical concepts). 

- Be able to elaborate, refine, analyze and evaluate one’s own ideas in order to improve and maximize 

creative efforts. 

- Use various types of reasoning (inductive, deductive, etc.) as appropriate to the situation. 

- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 

- Use technology as a tool to research, organize, evaluate and communicate information. 

- Use digital technologies (computers, PDAs, media players, GPS, etc.), communication/networking 

tools and social networks appropriately to access, manage, integrate, evaluate and create information 

to successfully function in a knowledge economy. 

- Develop innovative and creative ideas into forms that have impact and be adopted. 

- Utilize the most appropriate media creation tools, characteristics and conventions, expressions and 

interpretations in diverse, multi- cultural environments. 
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Similarly as in the previous topic, this topic belongs to the additional part of the Video box. Tasks are 

rather voluntary – it is up to the teachers to decide whether their children would like and be able to 

complete these tasks. The aim of the topic “Introducing your role mode” is to make children familiar 

with alternative possibilities of recording, editing a reviewing a video on the example of introducing 

their role models. 

Taskgroups and tasks 
This topic consists of three tasks. In the task 1 “Find your role model”, children will have the possibility 

to think about person they admire. In the task 2 “Introduce your role model “, they will make a video 

in which they will present their role model to other classmates. In the task 3 “Adding stuff to your 

video”, they will edit and add further features to the videos. 

Goals:  
- To let children think about their role models. 

- To continue working with mobile devices (record a video). 

- To use a video as a tool for elaborating own creative ideas. 

- To improve their technical skills in order to make a video more professional. 

Skills/Competences addressed: 
- Create new and worthwhile ideas (both incremental and radical concepts). 

- Be able to elaborate, refine, analyze and evaluate one’s own ideas in order to improve and maximize 

creative efforts. 

- Use various types of reasoning (inductive, deductive, etc.) as appropriate to the situation. 

- Speak with clarity and awareness of audience and purpose. Listen with care, patience and honesty. 

- Use technology as a tool to research, organize, evaluate and communicate information. 

- Use digital technologies (computers, PDAs, media players, GPS, etc.), communication/networking 

tools and social networks appropriately to access, manage, integrate, evaluate and create information 

to successfully function in a knowledge economy. 

- Develop innovative and creative ideas into forms that have impact and be adopted. 

- Utilize the most appropriate media creation tools, characteristics and conventions, expressions and 

interpretations in diverse, multi- cultural environments. 
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1: Video Getting started 

1a1 Working with QR codes 

You are going to use a mobile device as one of the tools for the video making and 
processing. First, you have to know how the mobile device can help you become a movie-
star. 
Discuss the questions below with your classmates: 

Fig. 1

 You can see a number of black-and-white square-type codes in the picture above.
Have you ever seen anything like that?

 What meaning could those codes have? Think of the bar codes you can see on
almost all goods bought in the stores.

 How can you use it?
 How can your mobile device recognize the code?

Try to scan the code in the top right corner of the sheet. 
 What can you see after your mobile device is able to recognize it?
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1: Video Getting started 

1a2 What is on my mobile device display? 

 Fig. 2a

You have probably noticed a number of symbols appearing on the screen of your mobile 
device. Do you know all of them? 

 Take a look at the symbols in the table below and discuss their meaning with your
classmates.

Fig. 2b 
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1: Video Getting started 

1a3 What apps do I have on my mobile device? 

Work in small groups and discuss following questions: 
 What kind of applications are already installed on your mobile devices?
 How many of these applications do you know? Have you ever used them? If yes, for

what kind of purpose?

 Fig. 3
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1: Video Getting started 

1a4 Taking pictures 

Use your mobile device to complete following task: 
 Take a picture of your best friend.

 Fig. 4

Upload the picture. 
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1: Video Getting started 

1a5 Adding effects to the photo 

Add some effects to the photo you have already taken: 
 Change the coloured photo to the grey scaled.
 Make the original photo brighter.
 Make the original photo darker.
 Change the original photo to the comic book-like photo.
 Change the original photo to the watercolour effect photo.
 If your mobile device offers some other effects, use them too!

Upload all your modified photos to our portal. 

 Fig. 5

Now, you can see the gallery of pictures which have been already uploaded. 
 Choose the picture from the gallery you like the most and discuss this decision with

your classmates.
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1: Video Getting started 

1a6 Further effects 

We continue with taking pictures: 
 Take at least three different pictures (for example: a photo of you, a photo of you

together with your friend and the photo of something you like the most in your
classroom).

 Create a collage with text and overlays.

Upload the collage. 

 Fig. 6

Now, you can see the gallery of collages which have been already uploaded. 
 Choose the collage from the gallery you like the most and discuss this decision with

your classmates.
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1: Video Getting started 

1a7 My first video 

Use your mobile device to complete following task: 
 Make a short introductory video of yourself.

Upload the video. 

 Fig. 7

Now, you can see the gallery of videos which have been already uploaded. 
 Choose the video from the gallery you like the most and discuss this decision with

your classmates.
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1: Video Getting started 

1a8 Summing up 

So far, you have been working on creating simple photos / collages / videos and editing 
them with various effects. Now, you can see all photos, collages and videos uploaded 
produced by you and your classmates on our portal. 

 Choose one photo you like the most (Note: it cannot be your own picture).
 Choose one collage you like the most (Note: it cannot be your own collage).
 Choose one video you like the most (Note: it cannot be your own video).
 Try to explain to your classmates in few words what you like about this photo /

collage / video the most.

Fig. 8    Fig. 9  Fig. 10

CONGRATULATIONS! ALL OF YOU HAVE JUST BECOME SMALL MOVIE STARS! 
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1: Video Do you want to be a YouTuber? 

1b1 Create a YouTube channel! 

Do you know how you can become a YouTuber? 
 Start with a Google account registration.
 Then, create your own channel!

 Fig. 11
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1: Video Do you want to be a YouTuber? 

1b2 Download YouTube application! 

Have you already downloaded the YouTube application to your mobile device? 
 In case you do not have it yet, go to the app-store and install it to your device.

 Fig. 12

Hint: Choose the appropriate app store on your device. Is it GooglePlay or AppStore? 
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1: Video Do you want to be a YouTuber? 

1b3 Find your favourite YouTube funny video! 

Use your mobile device to complete the following task: 
 What is your favourite funny YouTube video? Search it on YouTube.
 Send the link via the QR code.

Fig. 13

Why do you like it? How many people liked it? Look at the “thumbs up” below the video 
and discuss it with your classmates. 

45



1: Video Do you want to be a YouTuber? 

1b4 Record a video about famous person you admire! 

Some celebrities you may know have become famous only thanks to their homemade 
YouTube videos. 

 Do you know any famous YouTubers?
 Record a short video (at most 3 minutes!) about famous person you admire

(favourite singer / group or actor / actress / …).

     Fig. 14   Fig. 15

Once you are finished, upload the video. 
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1: Video Do you want to be a YouTuber? 

1b5 Be a journalist for one day! 

Be a journalist for one day! 
 Record an interview with your classmate – ask him / her questions about interesting

situations he/she has experienced over the past few days.

Fig. 16 Fig. 17

Once you are finished, upload the video. 
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1: Video Why are some videos good and others are not? 

1c1 First comes the plan! 

Think about the environment around your school. To make a really good video, you first 
need to plan your production.  

 Make a list of scenes and items you want to include in your video and prepare a
very simple screenplay.

Fig. 18 Fig. 19

Once you are finished, take a picture of the screenplay and upload it. 
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1: Video Why are some videos good and others are not? 

1c2 Learn how to make a really good video! 

Use your mobile device to complete the following task: 
 Based on your screenplay from the previous task, record the environment around

your school.

Upload the video. 

   Fig. 20  Fig. 21

 After every group records its own video, watch and discuss it together. You can talk
about the technical side of the video-production, overall production, new creative
ideas, well-produced parts of the video or about unclear / problematic parts of the
video, etc.

 Do you know what the following things are: tripod, establishing shot, shoot close,
cutaway shots, changing angles or positions?

    Fig. 22a           Fig. 22b         Fig. 22c

If not, try to google it. Have you missed something in the videos? What do you think would 
be nice or interesting when making a video (e.g. using a tripod to keep the shots steady and 
clean, recognizing appropriate shoot close, etc.)? Make a list of suggestions. Would you 
add some additional shots? 
Discuss everything together with your classmates. 
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1: Video Why are some videos good and others are not? 

1c3 Recognize the difference between the details and the whole 
surrounding! 

Now, we are going to focus on details. 
 Make a list of situations in which wide shots, medium shots or close-up shots are

suitable to use.
 Work in small groups. Each group will choose one of these categories and record

several examples of it.

Upload the video. 

 Fig. 23

Watch the examples together. Discuss whether the details in the videos were used 
appropriately. 
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1: Video Why are some videos good and others are not? 

1c4 Show us where you live! 

Use your mobile device to complete following task: 
 Record a video describing the place where you live.

 Fig. 24

Once you are finished, upload the video. 
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1: Video Be a professional movie editor! 

1d1 Simple video editing 

So far, you have been working on creating your own videos. 
 Select one of your videos saved on your device and import it into the video editing

application.
 Figure out which effects can be added to the videos using this application.
 Cut out the parts of the clip you are not satisfied with.
 Add some music to the video.
 Add at least one further effect you like to have in your video.

Fig. 25a Fig. 25b

Once you are finished, upload the video. 

 Fig. 26
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1: Video Be a professional movie reviewer! 

1e1 Prepare the final version of your video! 

For more than a month, you and your classmates have been working on your own videos. 
Now, you have plenty of recorded material. 

 Think of a way how you would like to present your short movies (e.g. combining
different parts of different videos) – prepare a simple screenplay, take a photo of it
and upload it to our portal.

 Follow your screenplay and create the final version of your video (cut & paste, add
music, add effects…)

 Fig. 27

Once you are finished, upload the video. 
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1: Video Be a professional movie reviewer! 

1e2 Give and receive feedback! 

After the QR code scanning, you are able to see the list of all final short movies your 
classmates have already made (including your own video). 

 Watch all short movies together.
 After watching each video, the producer of each video picks one classmate which

will to be the cameraman.
 The maker of the video asks the others what they liked / disliked about the video.

The cameraman has to record a short discussion in the class (max. 5 minutes!)
about this video.

 Fig. 28

Reminder to the cameraman: Do not forget to upload the discussion video to the YouTube 
channel! 
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1: Video Stop-motion video from drawings 

1f1 Understanding how stop-motion videos work 

Watch the following video: https://www.youtube.com/watch?v=cY207xbWwD8 
 Discuss with your classmates which steps are necessary for the creation of such a

video.
 After discussing it together, one of the students is required to write down the steps

(on a black / whiteboard or a sheet of the paper).

Fig. 29

Take a photo of it and upload it to our portal. 
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1: Video Stop-motion video from drawings 

1g2 Make your own video 

Work in small groups. 
 Write down a script of a short story.
 Take a photo of your script and upload it to our portal.
 Inspire yourself by the video from the previous task. Create your own stop-motion

video based on your script.

  Fig. 30

Once you are finished, upload the video. 
Note: It may happen that you will not be able to finish this task today. In that case, 
continue during the next session. 
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1: Video Stop-motion video from drawings 

1f3 Adding stuff to your video 

The video editor enables you to add your own comments, sounds, music, subtitles… You

can also apply slow motions and many other effects to your video!  
 Figure out which effects you can add to your video in the video editor. Use the editor

and try them. Which effects would help your video to look more professional?
 Write down a timeline / updated script of your video to which you add some effects.

You should apply the following effects: music, subtitles, own vocal comments. Of
course, you can add more!

Fig. 31

Once you are finished, upload the video. 
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1: Video Stop-motion video from toys 

1g1 Understanding how stop-motion videos work 

Watch the following video: https://www.youtube.com/watch?v=TBlNksMkGSc 
 Discuss with your classmates which steps are necessary for the creation of such a

video.
 After discussing it together, one of the students is required to write down the steps

(on a black / whiteboard or a sheet of paper).

 Fig. 32

Take a photo of it and upload it. 
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1: Video Stop-motion video from toys 

1g2 Make your own video 

Work in small groups. 
 Write down a script of some short story.
 Take a photo of your script and upload it to our portal.
 Inspire yourself by the video from the previous task. Create your own stop-motion

video based on your script (with toys, papers, pens, pencils, etc. – anything what
will be provided by your teachers).

 Fig. 33

Once you are finished, upload the video. 
Note: It may happen that you will not be able to finish this task today. In that case, 
continue during the next session. 

59



1: Video Stop-motion video from toys 

1g3 Adding stuff to your video 

The video editor enables you to add your own comments, sounds, music, subtitles… You 

can also apply slow motions and many other effects to your video!  
 Figure out which effects you can add to your video in the video editor. Use the editor

and try them. Which effects would help your video to look more professional?
 Write down a timeline / updated script of your video to which you add some effects.

You should apply the following effects: music, subtitles, own vocal comments. Of
course, you can add more!

 Fig. 34

Once you are finished, upload the video. 
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1: Video Trip to a ZOO / botanical garden / woods or any other 
place of interest 

1h1 Taking the pictures and recording the videos 

Your teacher will take all of you to some interesting place. 
 Your task is to take the pictures and record short videos of everything you consider

as interesting.

 Fig. 35

Our recommendations: Do not copy your classmates, be unique! It is not important how 
much material you have, but of which quality it is! Be aware that the device’s battery is not

unlimited and you may run out of battery earlier than you think! 
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1: Video Trip to a ZOO / botanical garden / woods or any other 
place of interest 

1h2 Making the video 

You visited some nice place during the last session. Today, you will work with the 
recorded material. 

 Watch all the videos and look at all pictures you took/recorded last time and think
how to make a nice short video of it.

 Write down a short script of the video you would like to make, take a photo of it and
upload it to our portal.

 Copy, cut & paste parts of video you would like to have included in your final short
video and work on this short movie.

 Fig. 36

Once you are finished, upload the video. 
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1: Video Trip to a ZOO / botanical garden / woods or any other 
place of interest 

1h3 Adding stuff to your video 

The video editor enables you to add your own comments, sounds, music, subtitles… You 

can also apply slow motions and many other effects to your video!  
 Figure out which effects you can add to your video in the video editor. Use the editor

and try them. Which effects would help your video to look more professional?
 Write down a timeline / updated script of your video to which you add some effects.

You should apply the following effects: music, subtitles, own vocal comments. Of
course, you can add more!

 Fig. 37

Once you are finished, upload the video. 
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1: Video Introducing your role model 

1i1 Find your role model 

Role model is a person you look up to. It can be whoever – a more or less known actor, 
singer, dancer, even your family member. 

 Think of your role model and try to find a photo of him / her online.

Fig. 38

Download his/her photo and upload it to our portal. 
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1: Video Introducing your role model 

1i2 Introduce your role model 

Record a short video in which you will describe your role model. You can tell: 
 why you like him / her,
 what he / she is good at,
 what his / her best known movie / song / book /… is, etc.

Fig. 39

Once you are finished, upload the video. 
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1: Video Introducing your role model 

1i3 Adding stuff to your video 

The video editor enables you to add your own comments, sounds, music, subtitles… You

can also apply slow motions and many other effects to your video!  
 Figure out which effects you can add to your video in the video editor. Use the editor

and try them. Which effects would help your video to look more professional?
 Write down a timeline / updated script of your video to which you add some effects.

You should apply the following effects: music, subtitles, own vocal comments. Of
course, you can add more!

Fig. 40

Once you are finished, upload the video. 
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